Table of Contents

READ ME FIRST  4
  Updates ............................................................................................................. 4
  Basics ............................................................................................................... 4

INTRODUCTION  7

iWEB QUICK START  8

WHAT’S NEW IN iWEB 3  10

A BRIEF HISTORY OF MAKING WEB SITES  11

INSTALL iWEB  15
  Run the Installer..............................................................................................15
  Get the Latest Version......................................................................................17

CREATE YOUR FIRST SITE  18
  Create a New Site............................................................................................18
  Choose a Template ............................................................................................19
  Choose a Page Type ..........................................................................................24
  Name Your Site ................................................................................................26
  Name Your Home Page .....................................................................................28
  Edit the Headline .............................................................................................30
  Change the Picture ............................................................................................31
  Edit the Heading and Body Text .......................................................................34
  Add Special Elements .......................................................................................35
  Change the Page Size & Background Color ....................................................37
  Make Your About Me Page ..............................................................................38

PUBLISH YOUR SITE  42
  Decide Where to Publish Your Site.................................................................42
  Site Publishing Settings ...................................................................................44
  Publish Your Site ..............................................................................................51
  Set Up a Personal Domain on MobileMe .........................................................54

WORK WITH TEXT  57
  Make Text Sparkle ............................................................................................57
  Create Web Hyperlinks .....................................................................................66
  Create Other Link Types ..................................................................................69

SHAPES, LAYERS & MASKS  72
  Shapes ..............................................................................................................72
  Layers ..............................................................................................................77
  Masks ...............................................................................................................79

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Read Me First

Welcome to Take Control of iWeb ’09, version 1.0, published in April 2009 by TidBITS Publishing Inc. This book was written by Steve Sande (with help from Doug McLean), edited by Karen Anderson (with help from Tonya Engst), and published by TidBITS Publishing Inc.

This book puts you in control of creating and publishing professional-looking Web sites using iWeb, Web design software from Apple Inc.

Copyright © 2009, Steve Sande. All rights reserved.

If you have the PDF version of this title, please note that if you want to share it with a friend, we ask that you do so as you would a physical book: “lend” it for a quick look, but ask your friend to buy a new copy to read it more carefully or to keep it for reference. You can click here to give your friend a discount coupon. Discounted classroom and Mac user group copies are also available.

UPDATES

We may offer free minor updates to this book. To read any available new information, click the Check for Updates link on the cover or click here. On the resulting Web page, you can also sign up to be notified of major updates via email. If you own only the print version of the book or have some other version where the Check for Updates link doesn’t work, contact us at tc-comments@tidbits.com to obtain the PDF.

BASICS

In reading this book, you may get stuck if you don’t know certain basic facts about iWeb or if you don’t understand Take Control syntax for things like working with menus or finding items in the Finder.
Please note the following:

• **Path syntax:** I occasionally use a *path* to show the location of a file or folder in your file system. For example, iLife ’09 installs its component applications, such as iWeb, in the Applications folder. The path to iWeb is: `/Applications/iWeb`.

The slash at the start of the path tells you to start from the root level of the disk. You will also see paths that begin with `~` (tilde), which is a shortcut for any user’s home directory. For example, if a person with the user name *andrea* wants to find her iWeb Domain file, she would look in the `~/Library/Application Support/iWeb` folder, which is another way of writing `/Users/andrea/Library/Application Support/iWeb`.

• **Menus:** When I describe choosing a command from a menu in the menu bar, I use an abbreviated description. For example, the abbreviated description for the menu command that saves a file from iWeb is “File > Save.”

**Version ’09 vs. Version 3**

You’ll see under iWeb > About iWeb that this program is called iWeb ’09 in general, and that the latest version number (as of this writing) is 3.0.1. For the sake of brevity, I refer to it as “iWeb 3″ when I’m talking about this version and call it simply “iWeb” the rest of the time.

• **Toolbar:** I refer to the iWeb toolbar (shown below this paragraph), throughout this book. You can find it at the bottom of the iWeb window, or—if you prefer to use menus or keyboard shortcuts, check out **Table 1**, next page, which maps the toolbar buttons to menu commands and keyboard shortcuts.

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
<table>
<thead>
<tr>
<th>Toolbar Icon</th>
<th>Menu Equivalent</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Theme Icon" /></td>
<td>File &gt; New Site</td>
<td>Shift-Command-N</td>
</tr>
<tr>
<td><img src="image" alt="TextBox Icon" /></td>
<td>Insert &gt; Text Box</td>
<td>None</td>
</tr>
<tr>
<td><img src="image" alt="Shapes Icon" /></td>
<td>Insert &gt; Shape &gt; [list of shapes]</td>
<td>None</td>
</tr>
<tr>
<td><img src="image" alt="Unmask Icon" /></td>
<td>Format &gt; Unmask / Mask</td>
<td>Shift-Command-M</td>
</tr>
<tr>
<td><img src="image" alt="Rotate Icon" /></td>
<td>Arrange &gt; Rotate Counter Clockwise</td>
<td>Command-R</td>
</tr>
<tr>
<td><img src="image" alt="Hide Media Icon" /></td>
<td>View &gt; Show / Hide Media</td>
<td>None</td>
</tr>
<tr>
<td><img src="image" alt="Adjust Icon" /></td>
<td>View &gt; Show / Hide Adjust Image</td>
<td>None</td>
</tr>
<tr>
<td><img src="image" alt="Inspector Icon" /></td>
<td>View &gt; Show / Hide Inspector</td>
<td>Option-Command-I</td>
</tr>
<tr>
<td><img src="image" alt="Colors Icon" /></td>
<td>View &gt; Show / Hide Colors</td>
<td>Shift-Command-C</td>
</tr>
<tr>
<td><img src="image" alt="Fonts Icon" /></td>
<td>Format &gt; Font &gt; Show / Hide Fonts</td>
<td>Command-T</td>
</tr>
</tbody>
</table>
Introduction

iLife ’09 arrived with much fanfare on January 6, 2009, at Macworld Expo. With many new features touted for iPhoto, iMovie, and GarageBand, it seemed as if iWeb had been given scant attention.

After working with iWeb 3—also known as iWeb ’09—for just a few minutes, I quickly realized that Apple made significant changes to the application. These address earlier shortcomings and make iWeb an even more powerful Web site design and publishing tool.

In previous editions of this book, I described a number of workarounds that allow publishing of your iWeb site to hosts other than MobileMe. Thanks to a new FTP (file transfer protocol) capability now built into iWeb, these workarounds are no longer needed. Similarly, several other processes I detailed in earlier editions have been eliminated or streamlined, as Apple has added new or improved functions.

In this book, I take you on a journey of discovery. I briefly explore the past so you can see what a powerful tool iWeb is, and then you can follow along as I build a Web site step by step using iWeb. You can visit my iWeb site at http://www.tcoiweb09.com/ and then read about how I used iWeb to create what you’re viewing.

If you’ve never made a Web site before, you’ll be thrilled with how easily you can organize your words and images and have iWeb turn them into a beautiful work of art. Experienced Web designers will be happy with the ways iWeb works with the rest of the iLife suite to create vibrant Web sites full of text, sound, video, and photography.

Let’s get started!
iWeb Quick Start

Although you can read this book sequentially, you may wish to use this page to set a custom path through the topics that I cover. You can click the blue links to jump quickly to a particular section.

Learn what’s new in iWeb 3:
• Find out how the changes in iWeb 3 help you create Web sites that are more compelling and powerful than those you could create in iWeb 2; see What’s New in iWeb 3 (p. 10).

Start your site:
• For historical context, read A Brief History of Making Web Sites (p. 11). Then, if you haven’t already, Install iWeb (p. 15).
• Start a new site! Learn how to Create Your First Site (p. 18).
• Get the scoop on Editing One Site on Two Macs (p. 41).
• Ready to take your site live? In Publish Your Site (p. 42), you’ll find out how to publish to MobileMe and to other servers. Appendix A: Web Hosting (p. 144) provides more detail about hosting your site on a server that is not MobileMe.

Add links:
• Learn about making links in Create Web Hyperlinks (p. 66) and Create Other Link Types (p. 69).
• If image-based links are more your fancy, find more info in Create Picture Hyperlinks (p. 119) and Make an Image Map (p. 120).
• Link to content from other Web sites with Add an RSS Feed (p. 100).
• Get social with your iWeb site. Read Add a Twitter feed (p. 103).

Add media:
• Turn your thoughts into bits with Publish a Blog (p. 82).
• Take your radio or TV show online with Publish a Podcast (p. 88).

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
• **Add Photos** to your site (p. 105), and learn how to use the iSight Photo widget, Photo pages, My Albums pages, and MobileMe galleries.

• Use iWeb to **Create an Online Movie Theater** (p. 121) and add videos from iMovie and YouTube.

**Create special effects:**

• **Add Special Elements** (p. 35) to count visitors and provide an email link.

• Learn how to **Make Text Sparkle** (p. 57) and discover the fabulous effects you can create with **Shapes, Layers & Masks** (p. 72).

• See **Enhance Photos** (p. 115) to add cool effects—like **Instant Alpha** (p. 118)—to your photos.

• Looking for extra income? **Add Google AdSense Ads** (p. 126), get ideas for how to **Run an Online Store** (p. 130), and **Increase Traffic** to your site (p. 142).

• **Add Google Maps** to give your readers directions with the Google Map widget (p. 129).

• **Add a Form** to your site in order to capture information from visitors (p. 137).
What’s New in iWeb 3

Let’s start by looking at what’s new or different in iWeb 3:

• **Publishing improvements:** Apple has drastically improved the process for uploading to Web hosts other than MobileMe by adding FTP capabilities to iWeb. See Use a third-party Web host (p. 43).

• **Updated user interface:** An improved Media Browser, accessed on the right side of the iWeb window or via the double-chevron button at the right side of the toolbar, provides instant access to your audio, photos, movies, and a larger collection of widgets.

• **iSight Movie widget:** You can now make a video podcast with the new iSight Movie widget, assuming you have an iSight camera handy. See Add an episode with the iSight Movie widget (p. 94).

• **iSight Photo widget:** Would you like to instantly add a picture of yourself to an iWeb site? You can Use the iSight photo widget to do so without opening any other applications on your Mac (p. 105).

• **More new widgets:** You can now add a Countdown timer (p. 36) to place a constantly updating countdown clock on your Web page, while the new RSS Feed widget adds updates from other Web sites, including your Twitter feed (read Add an RSS Feed, p. 100).

• **Integration with Facebook:** You can use the newly added integration with Facebook lets your Facebook buddies know when you’ve updated your iWeb site. To set this up, look for the Facebook option when you configure the Site Publishing Settings (p. 44).

• **Advanced gradient fills:** When adding a gradient fill to the background of a page or object, you now have more control over the type, direction, angle, and color of the fill with the Advanced Gradient Fill. See Background Fill (p. 61) for details.

• **Easier layering:** If you like to stack items as though you were piling them up on the Web page, you’ll be pleased with the new Bring to Front and Send to Back commands. To learn more and see examples, skip to Text layering (p. 65) and Layers (p. 77).
To appreciate just how powerful a Web site development tool iWeb is, it’s helpful to know a little about what it used to take to create and publish a Web site.

Beginning in 1991, the World Wide Web made the Internet vastly more useful and exciting for many people. Anyone with access to a Web server could put Web pages on the Internet, and anyone with a Web browser could look at them. Unlike earlier Internet applications, the Web wasn’t just straight text—Web pages could have colors, pictures, and other visual elements.

The language of the Web is HTML (Hypertext Markup Language). Created by Tim Berners-Lee as part of his original specification for the World Wide Web, HTML is a set of text instructions designed to tell a Web browser, like Safari or Firefox, where to place text, pictures, links, and other features on a Web page. (Find out more about Tim Berners-Lee at http://en.wikipedia.org/wiki/Tim_berners-lee.)

I was so excited by the invention of the Web and HTML, that I quickly downloaded the original NCSA Mosaic Web browser, visited the few sites that were available, and made my own Web site. What tool did I use to set up my original site? SimpleText. That’s right—the same tool we still use to read those ubiquitous Read Me files that seem to come with every new piece of software, although it’s now called TextEdit.

SimpleText was a good tool for developing Web sites in those days. Most sites consisted of a lot of text, hyperlinks to other sites, and had only a few graphics since most of us were using slow, dial-up modems to access the Internet. We would type the HTML into a text document and then view the more graphical result in a Web browser.
Here’s a simplified example of the HTML behind a basic Web page:

```html
<html>
<title>This is an example Web page</title>
<p><b>Welcome to my example Web page.</b><br />
The first few years of the World Wide Web were a lot like this. Pages had lots of text, a few tiny graphics, and links to other Web sites. Who could envision the changes we’d see? </p>
<p><a href="http://www.tcoiweb09.com/">A link to the example Web site for this book</a><hr>
<img src="http://www.takecontrolbooks.com/images/covers/cover_iweb_08-160x136.gif"></p>
</html>
```

When a Web browser receives the HTML shown above, it responds by showing a Web page that looks like the one in Figure 1.

![Figure 1](http://www.takecontrolbooks.com/images/covers/cover_iweb_08-160x136.gif)

**Figure 1:** In the early days of the World Wide Web, pages often looked like this one. In comparison to the rich visual options we have today, it’s a wonder that the Web took off like it did.
The items in the HTML that are surrounded by angle brackets (such as `<html>`) are called *tags*. Once you know the meaning of a few tags, you can see how they create a formatted Web page:

- **<html>**: The `<html>` tag defines the rest of the text as being readable by a Web browser. Notice that a closing tag, `</html>`, ends the text.

- **<title>**: The opening and closing `<title>` tags create the title at the top of the Web page.

- **<p>**: The `<p>` (paragraph) tag creates a paragraph. I could jazz up the text with a different font, italics, or bold-faced text, but for this example I left it plain vanilla.

- **<a>**: The `<a>` (anchor) tag has an *attribute*—a bit of text that clarifies what the tag should do. In this case, the attribute tells it what Web page to link to.

- **<img>**: The `<img>` (image) tag has an `src` attribute that gives the path to a graphic that I want to display on the page.

For the first few years, nearly everybody typed HTML by hand, although by late 1995 simple graphical editors, such as Adobe's PageMill (originally by Ceneca Communications), appeared on the scene. In their infancy, these *WYSIWYG* (What You See Is What You Get) editors were considered a godsend to those who didn’t want to think in HTML. On the other hand, they often generated HTML with oddities or bugs, and didn’t provide as much flexibility as hand-coding the HTML did.

At first HTML had only a few tags, so it was easy to learn. But, the W3C (World Wide Web Consortium) began adding new features to HTML based on input from Web designers and browser developers: they wanted improved graphics, beautiful and functional forms, better typography, and security. The W3C even developed *CSS* (Cascading Style Sheets) to provide additional flexibility in Web page layout.

Further, Web sites now often include special elements such as blogs, podcasts, videos, and video podcasts, available either directly from the site or via a system called RSS (Really Simple Syndication). In short, making a modern Web site can be difficult for amateurs and hobbyists, because it can require buying and learning to use expensive and complicated applications such as Dreamweaver.
Apple recognized the need for a simple, yet powerful Web design tool, and iWeb helps to fill that need, along with several other next-generation Web development tools, including:

- RapidWeaver: http://www.realmacsoftware.com/rapidweaver/
- Sandvox: http://www.karelia.com/sandvox/
- Freeway: http://www.softpress.com/

iWeb provides themes that serve as a starting point for designing a full-featured Web site. Integration with iPhoto, iMovie, iTunes, and even GarageBand extend the drag-and-drop options and let you add many types of media to enhance your Web site and enchant your visitors. Plus, the Widgets feature helps users add special items like Twitter feeds and Google AdSense advertising.

What you’ll find by the time you reach the end of this book is that you can use iWeb to design attractive Web sites full of photos, blogs, podcasts, and many special features—all without writing a line of HTML. I think you’ll also have a smile on your face when you see the results and realize you’ve spent only $79 on iLife ’09, instead of hundreds or even thousands of dollars for high-end Web design tools.

Enough of the history lesson—let’s get started.
Install iWeb

To install iLife ’09, your Macintosh must meet or exceed the following minimum requirements:

• A Mac with a Power PC G4 (867MHz or faster), PowerPC G5, or Intel processor (GarageBand Learn to Play requires an Intel-based Mac with a dual-core or faster processor), and at least 512 MB of memory (1 GB or higher is recommended; high-definition video requires at least 1 GB RAM). iWeb is a Universal application (so it runs on Power PC- and Intel-based Macs), and it operates much faster on the Intel-based machines.

• DVD drive.

• At least 4 GB of available disk space if you want to install all of iLife ’09. To install only iWeb, 750 MB should be sufficient.

• Mac OS X Leopard 10.5.6 or later.

• QuickTime 7.5.5 or later. iLife ’09 installs this on your Macintosh if it’s not currently installed.

If your Mac meets the requirements, grab your iLife ’09 disc and follow the directions in this section to install the software, make sure you have the latest version, and launch the software.

RUN THE INSTALLER

Before you install iWeb (or any software), I recommend that you quit any applications that are already running. I also suggest that you disable antivirus software, if you have it installed, to avoid possible conflicts with the installer. Remember to turn it back on once the installation is completed.

If you’ve installed other Mac software, you already know how to install iLife ’09: Open the box, remove the installation DVD, and place it in the Combo Drive or SuperDrive in your Macintosh. Soon the drive begins to whir and the DVD contents appear on the screen (Figure 2). Double-click the iLife ’09 icon to launch the installer.
Create Your First Site

In this section, I walk you through the basic steps for doing Web publishing in iWeb. You can follow along as I create a site, which I’ve put on the Web—at http://www.tcoiweb09.com/—so you can see it in action. You may wish to create a similar sample site, so you can get some practice. Alternately, you can skim this section to quickly find information about a particular topic.

CREATE A NEW SITE

The first time you launch iWeb, it either creates a new blank site for you or opens your existing iWeb Domain file (the file in which your iWeb sites are saved). Let’s look at both of these scenarios:

• **First launch ever:** iWeb creates a new blank site for you and greets you with a Welcome to iWeb ’09 dialog (**Figure 4**).

![Figure 4: The Welcome to iWeb ’09 dialog has an introductory video and links to more video tutorials on the Apple Web site. I recommend the tutorials as a supplement to this book.]

**Allow iWeb to access your keychain?** You may be asked whether to allow iWeb to use confidential information in your keychain. If this message appears, click the Allow button.
Publish Your Site

In this section, I help you figure out where to publish your site (MobileMe or somewhere else) and give you the necessary steps.

**DECIDE WHERE TO PUBLISH YOUR SITE**

A Web site is nothing if the rest of the world can’t see it. To publish your site so others can view it, you must copy its files to a Web server, a computer running Web-serving software that knows how to communicate with Web browsers. Usually, a Web server has an always-on connection to the Internet and—ideally—it is situated in a place where power outages, drive failures, and other problems are unlikely to occur. A service that provides you with space on a Web server, and takes care of all the maintenance and technical details of running a Web server is called a *Web host*.

From the perspective of an iWeb user, you have three main choices for your Web host, which I present next in what I consider the most likely option to the least likely.

**Use MobileMe**

Apple has made Web publishing easy by integrating iWeb with the MobileMe service. A site published to MobileMe can be open for the world to see, or it can be password protected for privacy. The URL to your Web site can either begin with www.mac.com, or you can host a personal domain (a registered domain name that you control) on MobileMe (see *Set Up a Personal Domain on MobileMe*, later in this section). A downside of publishing to MobileMe is that Apple doesn’t allow commercial activity on Web sites hosted there (see the Warning in *Run an Online Store* to read the rules about commercial activity).

Available for $99 per year, MobileMe provides 20 GB of storage, an email address, and many other features. If you would like to join, visit your local Apple Store or see [http://www.me.com/](http://www.me.com/). (Joe Kissell’s *Take Control of MobileMe* is a valuable source of information on how to make the most of MobileMe.)

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Work with Text

Even if you include fancy graphics or podcasts on your Web site, the text is the heart of your site and is worthy of your attention. In this section, I cover a grab bag of techniques that all relate to working with text: improving its look, avoiding issues with high-ASCII characters, and creating hyperlinks.

MAKE TEXT SPARKLE

iWeb’s professionally developed templates are nice, but you may want to customize the look of your text, perhaps in order to make your page stand out more. Although I don’t want to overdo it, I’d like to add pizzazz to my example pages by modifying text colors and styles, and applying effects such as opacity and rotation.

Fonts

If you have a special headline that needs to stand out, consider using a different font. Yes, I know I told you earlier not to use too many different fonts, and that basic rule still applies. However, judicious use of a special font can definitely change the way your Web page looks. As an example, I decided to change the text “Steve Sande” on the About Me page to make it stand out a bit. I selected the text by double-clicking it, and then clicked the Fonts button on the toolbar. Changing from the default Helvetica Neue font to plain Helvetica gave me the slightly bolder look I wanted.

Size

Size matters when it comes to text on Web pages. Headlines and titles should be larger than body text. To change text size without using the Font panel, select the text and press Command-Minus to make the text smaller or Command-Plus to make the text larger. There’s also a slider in the Font panel you can use to resize text on the fly.
Shapes, Layers & Masks

In this section, I talk about three powerful iWeb features—Shapes, Layers, and Masks. I touched on the topic of layers with respect to text objects in Work with Text, but there’s more to the story.

SHAPES

In iWeb, shapes are exactly what the name implies, pre-drawn shapes that you use to add excitement to your Web site. These include lines, arrows, circles, stars, rectangles, polygons, and even comic speech balloons. Shapes can behave in three different ways on your page:

- **Inline:** If you insert a shape just after clicking in a text block when a text cursor is flashing, the shape goes in the text as an inline graphic, meaning it behaves just like a regular character.

- **Wrapped:** You can change an inline graphic so that text in its paragraph wraps around it.

- **Fixed-object:** You can drag the object around freely on the page and place it where you like. Text does not wrap around it. (See Fixed-object shapes, ahead two pages.)

I discuss each of these options ahead, and I talk about Changing a shape (for instance, adding more points to a star) and about Adding text to the inside of a shape.

**Inline & wrapped shapes**

Follow along with me as I add an inline shape: First, I set the insertion point by clicking in the text where I want the shape to go. Next, I choose a circle from the Shapes pop-up menu on the toolbar. A circle surrounded by handles appears (Figure 40).

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Publish a Blog

Blog is a contraction of Web log, describing a Web site on which a writer, or group of writers, posts items on a regular basis focusing on a specific subject. The items typically include text, images, and links to other Web sites or Internet resources. Blogs display content in reverse chronological order, with the latest entries at the top of the page.

Although we didn’t call them blogs in the early days, blogs have been on the Web all along. Blogging took off in 2001 with the emergence of Blogger and other free Web-based blogging services that made it easy to add new blog entries and keep old entries organized. Blogging has become a popular means of communication and has been adopted by the mainstream media, although it is primarily known as an alternative media capable of affecting worldwide opinion.

In this section, I show you how to be an iWeb blogger.

WHAT’S ON AN iWEB BLOG PAGE?

iWeb’s Blog page type provides most of the elements of a classic blog:

• An overview page, with excerpts of the most recent posts listed in reverse chronological order

• Detailed blog entries on their own pages

• An archive of past entries that your readers can visit

• Comments with attachments (when the Web site is published to MobileMe)

• A tool for searching iWeb blogs (MobileMe only)
Publish a Podcast

What’s the fastest-growing new media on the planet? Podcasts. *Podcasts*, online radio or video shows, are consumed whenever, wherever, and however the listener desires. A typical podcast has three features:

- It has a number of episodes, all dealing with a particular subject.
- Listeners can subscribe to a podcast with podcatcher software, such as iTunes or Juice, to get the latest episode automatically.
- Listeners can enjoy a podcast on a mobile device, such as an iPod, iPhone, or other MP3 player.

Hundreds of thousands of podcasts are available today on almost any conceivable topic from “A Bluegrass and Old Time Radio Show” to “Zolfo Springs, Florida Weather.”

Video podcasts won’t necessarily appeal to people who like to listen while they do something else, but they do have advantages:

- It’s easier to demonstrate devices or processes when you can show what you’re talking about instead of describing it.
- The combination of sight and sound is much more engaging than audio alone. Would you rather see bright blue water, sparkling sand, and swaying palm trees in a travel podcast, or only hear the podcaster describing them?

In this section, I explain how to set up a podcast section on your iWeb site, and how to add content from GarageBand, the iSight Movie widget, iMovie, and the Finder. I also include directions for how to Add an RSS Feed and Add a Twitter feed.

Put an RSS or Twitter Feed in iWeb
Any RSS feed, whether it’s from the Twitter microblogging service, a blog, or a blog-like Web site, can now be displayed on an iWeb site, allowing you to show headlines (and sometimes content) from other sites in your iWeb site. To do this, jump ahead to the end of this section, where I discuss how to Add an RSS Feed.
Add Photos

Digital photos are great! It’s so easy to take pictures with your digital camera and transfer them to your Mac, then retouch and categorize them in iPhoto. With iWeb, it’s straightforward to add a gallery to your Web site so visitors can read about a vacation trip and then view pictures from the trip in an animated slideshow.

Here’s a summary of your options:

• **Insert a single photo:** If you just want to add a single photo, you can do so via the Media Browser or the Finder, but don’t miss trying the new iSight Photo widget to quickly add a photo of yourself (I cover the iSight Photo widget below on this page).

• **Photo pages:** You can Create a Photo Page to display as many as 300 photos on the page and offer a nice slideshow option.

• **My Album pages:** These Web pages organize multiple iPhoto albums on a single page. Once you Set Up a My Albums Page, viewers of the page can click an iPhoto album’s thumbnail-style cover image to open a Photo page showing its contents.

• **MobileMe galleries:** You can Work with MobileMe Galleries in iPhoto and publish them to your MobileMe account. Web galleries have several nice features for fun and easy viewing of photos, and you can put an animated, clickable, thumbnail-style image leading to a gallery on any page in iWeb.

Still More Info on Photos in the Next Section
For advice on enhancing the appearance of your photos using tools in iWeb, or for details on making them into clickable links, see the next section, Enhance Photos.

USE THE iSIGHT PHOTO WIDGET

As you’ve seen in earlier sections of this book, adding photos to an iWeb page is as easy as dragging one from the Media Browser or Finder, and then dropping it on the page or a placeholder. But did
Enhance Photos

iWeb gives you the power to do more with your online photos. In this section, I describe how to create interesting effects, frames, and shadows, and even how to use my favorite tool—Instant Alpha—to eliminate cluttered backgrounds in photos. I also cover how to turn almost any picture into a clickable hyperlink (see Create Picture Hyperlinks), and how to Make an Image Map.

THE FINE POINTS OF PHOTO FORMATTING

Here are my favorite tips for formatting photos in iWeb:

- **Removing, adding, or changing reflections:** Some iWeb templates automatically place a reflection under large pictures on certain pages. You can add, remove, or change reflections on almost any picture: select the picture, open the Graphic Inspector, and configure the “Reflection” checkbox and slider. Reflections cannot be added to photos that represent iPhoto Web galleries.

  Reflections aren’t always appropriate. I like them under large single photos on a page, but they seem distracting and unnecessary on pages with a lot of text or multiple photos. I tried reflections under the photos on the Examples page of my Web site and didn’t like them (Figure 70).

![Figure 70: Photos on a Web page without (left) and with (right) a reflection. Should you use a reflection? You make the call. In this case, I found the reflection distracting so I removed it.](image)

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Create an Online Movie Theater

Digital video is becoming much easier to produce, thanks to better camcorders and software like iMovie. You can share your digital videos with your Web site visitors by converting the videos to a Web-friendly, low-bandwidth format, then exporting them to iWeb. The process is extremely easy, once you’ve created the digital video. You can also Add a YouTube Video to your Web page using the YouTube widget.

I discuss both options in this section

Note: For information about video podcasting, flip back to the Publish a Podcast section, and especially check out the topics relating to iMovie and to the iSight Movie widget.

Import from the Finder? You needn’t have a movie in iMovie or YouTube to include it on an iMovie page. For example, you can drag a QuickTime movie into an iWeb page from the Finder.

ADD AN iMOVIE VIDEO

Once you’ve shared a movie from iMovie to Apple’s Media Browser, you can easily import it into other applications that use the Media Browser, including iWeb.

Here’s how to put your movie in the Media Browser and include it on an iWeb page:

1. With your edited movie selected in iMovie, choose Share > Media Browser.

   A dialog appears, asking you to select the format(s) for exporting your movies (Figure 75).
Money, Maps & More

A Web site can be a drain on your wallet, especially if it grows so popular that you’re charged for bandwidth and space usage overages. Wouldn’t it be nice if you could at least recoup part of the cost of running your Web site? Perhaps you have a great new product or service that you want to sell online. With iWeb and a little ingenuity, you can start selling your goods to the world.

Perhaps you’d like to add a form to your site, either to gather names or to conduct a survey. Or, maybe you’d like to add a map? I cover these options and more in this section.

ADD GOOGLE ADSENSE ADS

Google AdSense is the most prevalent example of an affiliate program. Affiliate programs provide advertising content to your Web site and provide a way to make ad revenue for your site. Apple and Google are close partners, and they’ve worked together to create an easy way for you to add Google AdSense ads to your iWeb pages.

Here’s how to sign up to show AdSense ads on your iWeb site:


2. In the resulting dialog (Figure 79), enter your email address and click Submit. (Of course, if you already are a member, click the I Already Have an Account button.)
Learn More & Do More

Continue your journey with iWeb by learning more about MobileMe, podcasting, and Web design. The publications and Web sites listed here are some of my favorites.

**Take Control ebooks:**
*Take Control of MobileMe*, by Joe Kissell (TidBITS Publishing, $10)

*Take Control of Podcasting on the Mac*, by Andy Affleck (TidBITS Publishing, $10)

*Take Control of Your Domain Names*, by Glenn Fleishman (TidBITS Publishing, $10)

**Books:**


*Web Design Garage*, by Marc Campbell (Prentice Hall, $34.99)

**Web sites**
Apple’s iWeb Forum
http://discussions.apple.com/forum.jspa?forumID=1309

Vincent Flanders’s *Web Pages That Suck*
http://www.webpages thatsuck.com/

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Appendix A: Web Hosting

The topic of hosting an iWeb site on a server that isn’t run by MobileMe could rightfully fill another book. However, it wouldn’t be fair to you to talk about setting up your own Web site without at least touching on the subject, so this appendix gives an overview of how to obtain a domain name for your Web site and find a Web host for it elsewhere than MobileMe.

To get a domain name and host your Web site elsewhere than MobileMe, follow these steps:

1. Decide at which Web location your site will be reachable. Web-hosting companies typically offer you one or more of the following choices for the start of a URL:

   - **A special path at the hosting company from a domain they control:** This is common for sites provided by your Internet Hosting Provider. The pattern is usually http://www.example.com/username/ or http://www.example.com/~username/.

   - **A subdomain at the hosting company:** A subdomain prepends a name to the front of a domain name; for instance, I host Web sites on my Podbus.com hosting service with URLs like http://mytestsite.podbus.com/.

     If you go with either of the above two options, skip to Step 1 in the next set of steps.

   - **Your own domain:** Many hosting companies are happy to create a virtual Web server for you at a domain name you choose and register through them or a third party. A virtual Web server resides on the same computer as dozens or even tens of thousands of other Web sites, but only responds when its name is “called” by a browser. For example, my Podbus.com servers host a number of Web sites, including the one used for the examples for this book. This type of hosting is usually slightly more expensive than using a path or a subdomain.
About This Book

Thank you for purchasing this Take Control book. We hope you find it both useful and enjoyable to read. We welcome your comments at tc-comments@tidbits.com. Keep reading in this section to learn more about the author, the Take Control series, and the publisher.

ABOUT THE AUTHOR

Steve Sande embraces change. After gathering his Bachelor of Science in Civil Engineering and MBA from the University of Colorado, he worked as an engineer until falling in love with the Mac in late 1984. He started a new life as an IT manager and unofficial Mac evangelist, at one point managing a team supporting over 1,200 Macs.

In late 2004, Steve embarked on a new career as a certified Mac consultant. When he’s not haunting the local Apple Stores, working with clients, or writing ebooks, he loves to cook, go geocaching, sing, ride his recumbent bicycle, collect and create art, and attend classical music concerts. He’s also an instructor for ASPE Technology facilitating Business Analysis classes (http://www.aspe-sdlc.com/). Since the spring of 2008, he’s been blogging iPhone and Mac news on The Unofficial Apple Weblog (http://www.tuaw.com/). You can follow Steve on Twitter (http://www.twitter.com/stevensande/).

Steve lives in Highlands Ranch, Colorado, with Barb—his wife of 30 years, who really is a rocket scientist—and his tortoiseshell cat, Ruby.
AUTHOR’S ACKNOWLEDGMENTS

I’d like to thank several people for their support during the creation of this book:

- **Barb Sande**, my wonderful wife, for putting up with me typing away on my computer at all hours of the day.

- **Tonya Engst**, for being such an unbelievably patient, hard working, and understanding editor-in-chief.

- **Karen Anderson**, for taking on the daunting task of editing this book and being patient with a person who is notoriously slow at creating updates.

- **Doug McLean**, for his sharp eyes and unfailing logic in pointing out sections of the book that needed work.

SHAMELESS PLUGS

If you’re a Mac user who lives nowhere near an Apple Store, and you need some help or training, my Mac consulting firm, Raven Solutions, LLC ([http://im4macs.com/](http://im4macs.com/)), offers remote online support services. When I’m not available, one of my team of Apple certified consultants can help out.

I also run a Web and podcast hosting company called Podbus.com. Our rates are low, our service is great, and we offer a money-back satisfaction guarantee ([http://www.podbus.com/](http://www.podbus.com/)).

ABOUT THE PUBLISHER

Publishers Adam and Tonya Engst have been creating Macintosh-related content since they started the online Web site and newsletter *TidBITS*, in 1990. In *TidBITS*, you can find the latest Macintosh news, plus read reviews, opinions, and more ([http://www.tidbits.com/](http://www.tidbits.com/)). Adam and Tonya are known in the Mac world as writers, editors, and speakers. They are also parents to Tristan, who thinks ebooks about clipper ships and castles would be cool.
PRODUCTION CREDITS

Take Control logo: Jeff Tolbert
Cover design: Jon Hersh
Author’s Assistant: Doug McLean
Editor: Karen Anderson
Editor in Chief and template master: Tonya Engst
Publisher and grep automation master: Adam Engst
General Assistant: Julie Kulik

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Take Control of iWeb ’09
Copyright © Steven P. Sande, 2009. All rights reserved.

TidBITS Publishing Inc.
50 Hickory Road
Ithaca, NY 14850 USA
http://www.takecontrolbooks.com/

Take Control electronic books help readers regain a measure of control in an oftentimes out-of-control universe. Take Control ebooks also streamline the publication process so that information about quickly changing technical topics can be published while it’s still relevant and accurate.

This electronic book doesn’t use copy protection because copy protection makes life harder for everyone. So we ask a favor of our readers. If you want to share your copy of this ebook with a friend, please do so as you would a physical book, meaning that if your friend uses it regularly, he or she should buy a copy. Your support makes it possible for future Take Control ebooks to hit the Internet long before you’d find the same information in a printed book. Plus, if you buy the ebook, you’re entitled to any free updates that become available.

Although the author and TidBITS Publishing Inc. have made a reasonable effort to ensure the accuracy of the information herein, they assume no responsibility for errors or omissions. The information in this ebook is distributed “As Is,” without warranty of any kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person or entity for any special, indirect, incidental, or consequential damages, including without limitation lost revenues or lost profits, that may result (or that are alleged to result) from the use of these materials. In other words, use this information at your own risk.

Many of the designations used to distinguish products and services are claimed as trademarks or service marks. Any trademarks, service marks, product names, or named features that appear in this title are assumed to be the property of their respective owners. All product names and services are used in an editorial fashion only, with no intention of infringement of the trademark. No such use, or the use of any trade name, is meant to convey endorsement or other affiliation with this title.

This title is an independent publication and has not been authorized, sponsored, or otherwise approved by Apple Inc. Because of the nature of this title, it uses terms that are trademarks or registered trademarks of Apple Inc.; to view a complete list of the trademarks and the registered trademarks of Apple Inc., you can visit http://www.apple.com/legal/trademark/appletmlist.html.

Click here to buy the full 152-page “Take Control of iWeb ’09” for only $10!
Now that you’ve seen this book, you know that Take Control books have an easy-to-read layout, clickable links if you read onscreen, and real-world info that puts you in control. Click any book title below or visit our Web catalog to add more ebooks to your Take Control collection!

*Take Control of Your Domain Names* (Glenn Fleishman): Get expert help with registering, configuring, and managing your Internet domain names like a pro! $10

*Take Control of Making Music with GarageBand ’09* (Jeff Tolbert): Combine your creativity with GarageBand’s editing and mixing techniques to compose tunes that please the ear! $10

*Take Control of Recording with GarageBand ’09* (Jeff Tolbert): Create musical compositions with vocals, drums, guitars, and even the kitchen sink! $10

*Take Control of Podcasting on a Mac* (Andy Affleck): Start podcasting or take it to the next level with our step-by-step guide! $10

*Take Control of MobileMe* (Joe Kissell): This ebook helps you make the most of the oodles of features provided by a $99-per-year MobileMe subscription. $10

*Take Control of Syncing Data in Leopard* (Michael Cohen): Is your data stuck on your Mac? Learn how to sync it with another Mac, iPhone, iPod, mobile phone, or PDA! $10

*Take Control of Users & Accounts in Leopard* (Kirk McElhearn): Find straightforward explanations of how to create, manage, and work with—and among—user accounts. $10

*Take Control: The Mac OS X Lexicon* (Andy Baird and Sharon Zardetto): In this definitive guide, you’ll find over 500 of the most important Macintosh- and Internet-related terms. $15